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Basic Book Design

This guide is aimed at the self-publishing author who is using print-on-demand printers such as 
CreateSpace, Lulu, etc. Your design task is easier than it would be with lithographic book publish-
ers—who build books in signatures of 16, 32, or 64 pages, and who might accommodate the design 
process by adding a sheet consisting of 4 pages—because you can add or subtract two pages at a 
time. Here is how to start.

Software

I assume you are are not going to learn a new, desk top publishing application like Scribus (free), 
let alone, buy Adobe’s InDesign, to make one book. If you have Word or Open Office, Word Per-
fect or Works, you can convert your manuscript into a book. Every application is different, but the 
concepts are the same. Desktop publishing software creates pages with more typographical control 
than a word processor, and easily export to PDF,  but you need to consider the learning curve. For 
the purposes of this guide, it doesn’t matter what application you are using.  

Readability, Aesthetics, Size and Cost

Throughout the design process, your overarching concern is a balancing act, which too often 
involve things that are mutually exclusive. You want your book to be 

easily readable with minimal eye fatigue;  •	
aesthetically pleasing and appropriate for your book.•	

To simplify this, you want larger type and good size and practical margins—if the inside margin is 
too small, it is hard to read as the lines disappear into the gutter.  Working against this is:

the bigger the book, the more it costs.•	
Assume that your manuscript is 60,000 words, and you are going to design a 6" X 9" book: 

Type Margins
 Inner           Outer           Top           Bottom

Words
/Page

Lines
/Page

Total
Pages

Cost @
.012/pg.

Courier (ms.)
12/24* 1.25" 1.00" 1.00" 1.50" 184 23 326
Times New Roman
14/16 0.75" 1.00" 1.00" 1.25" 239 30 251 $3.12
12/14 0.75" 1.00" 1.00" 1.25" 317 35 190 $2.28
11/12 0.75" 1.00" 1.00" 1.25" 393 40 153 $1.84
10/12 0.75" 1.00" 1.00" 1.25" 442 41 136 $1.63
10/12 0.50" 0.50" 0.625 0.625" 584 47 102 $1.22

* The first number is the type size and the second number is the leading. Therefore 12/14 (read “12 on 14”) means 12 point type with 2 point leading.  

Getting Started
Most books are set in serif fonts, which are easier to read. Display and sans serif fonts are typi-

cally reserved for headings, titles, etc.  The actual number of pages listed above will vary depending 
on how much dialogue you have, the style of chapter openings, etc. 
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Courier 12/24, 184 words/page             Times 14/16, 239 words/page        Times 12/14, 317 words/page
         on 8½" x 11" paper

   Times 11/12, 393 words/page             Times 10/12, 442 words/page        Times 10/12, 584 words/page

With these trade-offs in mind, you will begin to work out a design and determine the size of 
your book. The next few steps don’t necessarily occur in any particular sequence, and may be done 
concurrently: 1) look at other books; 2) create a design file for playing with type and margins (the 
ideal design); 3) create a working file into which you will insert your manuscript.   

There is no perfect, one-size fits all, book design layout. The look of the page should reflect the 
subject matter and be aimed at your ideal audience. The next section of this PDF introduces some 
basic typographic concepts. 
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Look at books you like. There is no better way to see how things work than to look at how other 
people have solved their design problems. Pick one you like as a model. Note: Many print-on-
demand printers have minimum margins. Particularly, inner margins that 1) must be adhered to; 
and 2) are considerably larger than most books.  

Create a design file to the trim size of your book, I’ve used 6" x 9" in these examples. Measure 
the margins of the model book, and set them in this document. Then count the number of lines on 
a typical page; 

Lines per page vary because most designers try to avoid widows—the last line of a paragraph that 
starts a new page—and at the same time keeping each page of a spread the same length. This is done 
by adjusting the letter and word spacing—to add a line or remove a line of type—but sometimes 
that leads to other widows. This is puzzle solving: every change effects what is downstream, and 
you often find a page that needs going back and forth until it fits. A last resort is to remove or add 
a line or two to facing pages.

this will be your guide to matching the type specification of your model (designers use a type gage, 
which is placed over a block of type). Paste in 500-600 nonsense words,

Commonly called Lorem ipsum, this is miscellaneous Latin words that give a word length distri-
bution similar to English text. Unlike using the actual text of your manuscript, which can be dis-
tracting, Lorem ipsum lets the designer concentrate on the appearance of the text. You can get any 
length Lorem ipsum free from www.lipsum.com. 

which you can then adjust, to get the same number of lines. If you only have a few fonts, like the 
ones that come with Window, you might want to look on line for type. Adobe, Linotype, Mono-
type, to name three, make spectacular and full type fonts; although they can be expensive, most 
companies have specials. There are also thousands of very good free-ware fonts. These can be as 
good as the top end fonts, but usually they do not come as full families (Roman, italic, in semibold, 
bold etc.). 

When you get a block you like, add headers and chapter openings. After you’ve tweaked them to 
what you like, you have a good place to start your book. 

Of course you could meld this step into the next one, but having this step doesn’t add much time 
and makes design easier.   

Create a working file. Create a file that is set to what you think you want: trim and margins. 
Mark the first six or so pages for the front matter, for example: “[Half Title],” “[Facing Title Blank],” 
“Title],” “[Copyright],” “[Dedication].” “[Facing Chapter Blank],” and whatever additional pages 
your particular book will have. Each of these pages could include a page break. Insert your manu-
script. Select all of your text and apply a type face, size, and leading. If you have worked out the 
chapter openings, apply the formatting.    

You now know, give or take a few pages, the length of your book. If you want it shorter or longer, 
you can change the font, adjust the type size and leading, adjust the margins. 

For a nice looking book: 
Go through your book looking for widows (a line ending a paragraph at the top of a page—I left •	
a widow at the top of this page—and remove them). Remove them by compressing or expand-
ing type a little bit to add or remove lines.
Look for and correct rivers: a streak, river, of white space running down through several lines •	
of type. Adjust the word spacing.  
Make sure all type/spacing effects are identical: e.g. chapter headings, block quotes, etc. •	
Chapter endings that are only a line or two should be avoided.•	



6

Check List

Margins: Top: ______, Bottom ______, Outer _____, Inner _____

Title of Chapter: Spacing above_____, spacing to text _____, Type ____________, size ____
                              Initial: drop cap _____, stick-up _____ 
                              First phrase: letter spaced caps_____, small caps _____ 
Running titles:    Verso (left) content_____________________ , type _________, size ____
                              Recto (right) content____________________, type _________, size ____

Folios:                  Front matter:_________________________________________________
                              Text:
                              Back matter: 

Main Text: Type face__________, size ____, leading ____, paragraph indent____

Secondary text: Type face __________, size ____, leading ____, indent ____

Lists: number _____, indent ____, misc ____

Tables: _________________________________________________________________

Poems:                 Title: type _________, size ____, alignment _______________
                              Poem: type ________, size ____, leading ____, alignment/indent_________

Footnotes:            Symbols ___________________________________________________
                              Type size:_____, leading _____
                              Endnotes: type size _____, leading _____, indent___________

Glossary

Bibliography

Legends & Captions

Index
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Type & Typography

A
rt is the elegant display 
of the structure of things. We can only 
speak of art in poetic terms, when lan-

guage is art. It is experience—a moment of com-
munion. How easy to strip it bare with a few care-
less words. Like words cast in anger, they ripple 
against what we love forever. The mystery of a 
thing is often quite simple.  — Otto Roeper

A B C DE  F GHI 

V U TSR   Q P O N

M
L

K
JZ

Y
X

W
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Type and Typography
Faced with the veritable demise of handset type, Hermann Zapf, the creator of Aldus, 

Optima, and Palatino, was asked what the craftsman-typesetter would do. Zapf said the 
he would keep a composing rule and type, and at lunch he would set a beautiful line of 
type.  

Setting type is a craft. However, with your computer you have the ability to exceed what 
most computer and photo typesetters could do in the 1980’s. Can you typeset a book in 
Word, for example, and save it as a PDF? Yes, but with some trouble: Word, and similar 
word processing programs can do the near miraculous, but Word has a habit of re-pag-
inating and large documents can vary considerable. Once you convert your file to PDF 
format it is stable—although sometimes you might have to do this several times before it 
is right—and most printers can print from PDFs.      

Programs like InDesign offer virtually unlimited control over type, but Word, for ex-
ample, gives you the ability to set professional looking pages—to expand or contract letter 
and word spacing (Format> Font>Character Spacing), drop caps (Format>Drop Cap), 
and paragraph formatting, mirrored page margins (Page Setup>Margins), etc.  
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Type styles and Letter Spacing: The parts of a glyph have names, the most important distinc-
tions are between serif and sans serif, roman and italic.  Normal letter spacing is subtly adjusted to 
avoid typographical problems, such as widows, orphans, and rivers; open, touching, or expanded 
are most often used in display matter. 
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ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

Regular

Bold Condensed

Bold Condensed Italic

Italic

Medium

Medium Italic

Semibold

Semibold Italic

Bold 

Bold Italic

Styles of type: Each family of type (these font examples are all members of Minion Pro), can 
have variations ranging from light condensed to extra bold extended. Not all fonts have all pos-
sible characters, and not all families have all possible fonts.  
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Classification of Type Faces: There are eight classes of type: old style, transitional, modern, 
square serif, sans serif, cursive and scrips, text letters, and decorative types. 

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
 abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$( )[ ]

Old Style
Century Old Style
rugged, unsymmetric, 
good readability

Transitional
Requiem
Midway between old 
style and modern

Modern
Bodoni
“mechanically perfect,”
delicate hairlines

Square Serif (Egyptian)
Chaparal
straight serifs and rela-
tively even strokes

Sans Serif
Arial
no serifs

Script
English Script
resembles script and 
letters connect

Cursive
Alison
formal, calligraphic
letters do not connect

Text
Old London
called gothic or old 
English, or black letter

Decorative 
Berhnard Fashion
also novelty, a catchall 
classification
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Variations: There are too many variations within the major classifications to even touch on the 
possibilities, but we are showing some groupings: typewriter, open or outline, stylish variations 
on sans serif, handwriting—printed, handwriting—cursive, brush, foreign—Greek, foreign—Ar-
ab, cartoon. 

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 

ABCDEFGHIJKLMNOPQRSTUVWXYZ

1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,/!&%$#( )[ ]

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890 .,!( )

Typewriter
Courier
monospaced, square 
serif

Open or Outline
Grenoble Outline
can be serif or non serif

Stylized Sans Serif
Optima
graceful variations in 
the strokes

Handwriting—printing
Feltpen

Handwriting—cursive
Zephy

Brush
Painty paint

Foreign—Greek
Marathon

Foreign—Arab
Arab Dances

Cartoon
Smartie Caps
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Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, com-
modo a, posuere at, tristique in, velit. Nam porta magna sit amet magna. Nulla 
accumsan arcu ac turpis. Pellentesque gravida pede eu purus. Aliquam facilisis 
faucibus pede. Ut varius nibh auctor pede. Nullam condimentum diam sed diam. 
Class aptent.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, com-
modo a, posuere at, tristique in, velit. Nam porta magna sit amet magna. Nulla 
accumsan arcu ac turpis. Pellentesque gravida pede eu purus. Aliquam facilisis 

faucibus pede. Ut varius nibh auctor pede. Nullam condimentum diam sed diam. 
Class aptent.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, com-
modo a, posuere at, tristique in, velit. Nam porta magna sit amet magna. Nulla 
accumsan arcu ac turpis. Pellentesque gravida pede eu purus. Aliquam facilisis 

faucibus pede. Ut varius nibh auctor pede. Nullam condimentum diam sed diam. 
Class aptent.

   Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, 
        commodo a, posuere at, tristique in, velit. Nam porta magna sit amet magna. 
                Nulla accumsan arcu ac turpis. Pellentesque gravida pede eu purus. 
       Aliquam facilisis faucibus pede. Ut varius nibh auctor pede. 
                             Nullam condimentum diam sed diam. Class aptent.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, com-
modo a, posuere at, tristique in, velit. Nam porta magna sit amet magna. Nulla 
accumsan arcu ac turpis. Pellentesque gravida pede eu purus. Aliquam facilisis fau-
cibus pede. Ut varius nibh auctor pede. Nullam condimentum diam sed diam. Class 
aptent.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nam arcu ipsum, commodo 
a, posuere at, tristique in, velit. Nam porta magna sit amet magna. Nulla accumsan 
arcu ac turpis. Pellentesque gravida pede eu purus. Aliquam facilisis faucibus pede. 
Ut varius nibh auctor pede. Nullam condimentum diam sed diam. Class aptent.

Unjustified (flush left, 
ragged right)

 

Unjustified (flush right, 
ragged left)

Centered

Asymmetrical

Justified

Justified
No hyphenation

Margins: Type can be arranged in five ways between the vertical margins: 1) unjustified—flush 
left, ragged right; 2)  unjustified—flush right, ragged left; 3) centered; 4)  asymmetrical; 5) justi-
fied; and 6) justified with no hyphenation.  
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Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin 
imperdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis par-
turient montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum 
eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleif-
end. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, 
ipsum turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit 
amet elit rhoncus porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur 
risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, 
hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor 
in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin 
imperdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis par-
turient montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum 
eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleif-
end. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, 
ipsum turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit 
amet elit rhoncus porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur 
risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, 
hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor 
in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin 
imperdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis par-
turient montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum 
eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleif-
end. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, 
ipsum turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit 
amet elit rhoncus porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur 
risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, 
hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor 
in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin 
imperdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis par-
turient montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum 
eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleif-
end. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, 
ipsum turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit 
amet elit rhoncus porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur 
risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, 
hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor 
in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Century 
10/10

 

 

Century 
10/12

Century
10/14

Centrury
10/16

Leading: Line spacing. Pronounced “ledding.” “10/10 is read “10 on 10.” It comes from the 
strips of led inserted between lines of handset type.  10/10 has no leading; 10/12 has 2 points of 
lead, etc. Here the same amount of copy, all set in 10 point type, is shown solid (no leading) to 6 
points of leading. Readability increases as the expense of how many words would fit on a page. 
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Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin 
imperdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis par-
turient montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum 
eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleif-
end. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, 
ipsum turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit 
amet elit rhoncus porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur 
risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, 
hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor 
in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. 
Praesent vitae arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin im-
perdiet. Sed viverra ultricies nisi. Cum sociis natoque penatibus et magnis dis parturient 
montes, nascetur ridiculus mus. Donec non erat. Nam arcu lorem, vestibulum eget, port-
titor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleifend. Aliquam at 
risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, ipsum turpis fau-
cibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit amet elit rhoncus 
porttitor. Suspendisse sed nulla id augue mollis rutrum. Curabitur risus massa, auctor in, 
blandit vel, consectetuer ut, sapien. Sed dui enim, commodo et, hendrerit quis, blandit eu, 
pede. Ut viverra cursus velit. Curabitur justo justo, tempor in, ullamcorper at, facilisis nec, 
erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. Praesent vitae arcu. 
Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin imperdiet. Sed viverra ultricies nisi. Cum 
sociis natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Donec non erat. Nam arcu 
lorem, vestibulum eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue interdum eleifend. 
Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, ipsum turpis faucibus 
ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit amet elit rhoncus porttitor. Suspendisse sed 
nulla id augue mollis rutrum. Curabitur risus massa, auctor in, blandit vel, consectetuer ut, sapien. Sed dui 
enim, commodo et, hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur justo justo, tempor in, 
ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Proin accumsan facilisis velit. Praesent vitae 
arcu. Quisque nec sapien nec leo consequat luctus. Cras tincidunt. Proin imperdiet. Sed viverra ultricies 
nisi. Cum sociis natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus. Donec non 
erat. Nam arcu lorem, vestibulum eget, porttitor eget, pharetra quis, nunc. Curabitur a risus nec augue in-
terdum eleifend. Aliquam at risus. Ut at lorem. Aliquam lacinia, augue sed consectetuer venenatis, ipsum 
turpis faucibus ipsum, vitae imperdiet turpis lorem in orci. Vivamus a justo sit amet elit rhoncus porttitor. 
Suspendisse sed nulla id augue mollis rutrum. Curabitur risus massa, auctor in, blandit vel, consectetuer 
ut, sapien. Sed dui enim, commodo et, hendrerit quis, blandit eu, pede. Ut viverra cursus velit. Curabitur 
justo justo, tempor in, ullamcorper at, facilisis nec, erat. Vivamus quis orci a neque pulvinar blandit.

Century 
10/12

Book Antiqua
10/12

Bernard Modern
10/12

Requiem
10/12

Color: The tone or density of a text block on a page.  The style of a typeface not only should say 
something about what is set with it, but blocks of text are ‘colored” by the choice of type.   
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Delete: take out 	           Once upoon a time	     Once upon a time
Insert: letter or word        One upon a time          Once upon a time
Italicize                            Once upon a time        Once upon a time
Insert space                      Once upona time         Once upon a time
Close up space                 Once upo   n a time     Once upon a time
Insert a comma                Once upon a time        Once, upon a time
Insert period                     Once upon a time        Once upon a time.
Replace with capital        once upon a time         Once upon a time
Replace with lowercase   ONce upon a time       Once upon a time
Replace with roman         Once upon a time        Once upon a time
Replace with bold            Once upon a time        Once upon a time
Replace with bold italic   Once upon a time        Once upon a time  
Move to the left                    Once upon a time  Once upon a time 
Move to the right         Once upon a time           Once upon a time
Transpose                        Once a upon time        Once upon a time
Let Stand                         Once upon a time        Once upon a time
Replace with small caps  Once upon a time        Once upon a time
Run in                              Once upon                   Once upon a time 
                                         a time
Center                              Once                                     Once 
Move Down                     Once upon a time       Once upon a time
Move Up                          Once upon a time        Once upon a time
Insert quotation marks     Once upon a time        “Once upon a time”
Insert a colon                   Once upon a time        Once upon a time:
Insert a semicolon            Once upon a time        Once upon a time;
Insert an apostrophe        Once pon a time          Once ’pon a time
Insert a hyphen                  Once upon a time        Once upon a time-
Insert an em dash             Once upon a time        Once upon a time―
                     

   Marginal
      Mark    Explanation                        Example                         Corrected

Proof Reader’s Marks

Proofreader’s Marks: These are the most common, but no means all, marks. We have excluded 
marks the apply to handset metal type. The marks are impossible to use unless dealing with text 
on paper. Tests have shown that comprehension improves when text is read on paper rather than 
a monitor—therefore our recommendation is to print things out.   
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The Parts of a Book
	 The content of a book can be divided into three sections: 1) front matter, 
also calls preliminaries (prelims); 2) the text; 3) the back matter or end mat-

FRONT MATTER                                                                                                                                           
   

Half title (bastard title)                                                          i*
Blank, or: frontispiece, series title, books by the author       ii*
Title page                                                                               iii*  
Copyright page                                                                      iv*
Dedication                                                                              v*
Blank                                                                                      vi*
Table of Contents                                                                   v or vii*
Table of Illustrations                                                             recto*
List of Tables                                                                         recto*
Forward                                                                                  recto
Preface                                                                                    recto
Acknowledgments                                                                  recto
Introduction                                                                           recto

TEXT

First Test Page; or Second half title or first part title             1
Blank                                                                                      2
First Text Page                                                                          3      

BACK MATTER

Apendix                                                                                 recto
Notes                                                                                      recto
Gloassary                                                                               recto
Bilbliography                                                                         recto
Index                                                                                     recto

* Typically unnumbered. The page numbers would be non-printing, or blind folios.

Very few books have all the listed sections.  The first page number always odd, 
(1), it is always on the right side, and all right-hand pages are odd (they are 
called recto); the left-hand pages are all even (they are called verso).  
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                                                                                                             Half Title Page

The half title is the main title. The subtitle and author’s name are omitted.  

Exceptions or Variations

Some designers add a page before the half title, blank on the recto, listing the author’s 
works on the verso. In this system, the next page, iii, would be the half title.

Page Numbers

From this first page to the blank page before the first text page, which could be the in-
troduction, forward, acknowledgment, etc., these pages are typically not numbered. 
These pages are counted, however, when you number, for example, the introduction, 
which could start on page vii. Pages without page numbers are said to have blind fo-
lios.

.
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                            Facing Title Page                                        Title Page

The facing page may be 1) blank; 2) the frontispiece; 3) series title; 4) books by the 
author; 5) part of the title page.

The title page gives the full title, name of author, editor, or translator, name of pub-
lishing house, and sometimes the city of publication or where corporate offices are 
located, and the year. These pages are rarely numbered, see page 18.  
\
Design Considerations

The title and subtitle are usually set in different fonts: therefore no punctuation is 
needed to separate the title from the subtitle.  

The author’s name should be printed in the form he prefers.  Affiliations and degrees 
are usually omitted, except “M.D.”

For editors and translators: “Edited by John Doe” and “Translated by John Doe” are 
the proper form, not “John Doe, Editor.”

The publisher’s trademark or logo may appear.  

Some designers use the  facing title page as part of the full title.   
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                                 Copyright Page                                               Dedication Page

The most important part of the copyright page is the copyright notice, which con-
tains three elements (from http://www.copyright.gov/circs/circ1.pdf page 4):

1. The symbol © (the letter C in a circle, or the word “copyright,” or the 
abbreviation “Copr.”; and
2. The year of first publication of the work.  In the case of compilations or 
derivative works incorporating previously published material, the date of 
first publication of the compilation or derivative work is sufficient. . . .
3) The name of the owner of the copyright in the work, or an abbrevia-
tion by which the name can be recognized, or a generally known alter-
native designation of the owner.  

Example: © 2008 John Doe

Following the copyright notice, most publishers put “All rights reserved”: to conform 
to the Buenos Aires Convention “a statement of reservation of property rights” must 
be included.  

 In addition to the copyright notice, the page also included: publishing history, pub-
lishers mailing address, ISBN, county where book was manufactured, catalog/author 
information, and, original title if different.

These pages are rarely numbered. See page 18.
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                          Facing Contents Page	                             Contents Page

The facing contents page is blank.  

The Contents (Table of Contents, List of Illustrations, List of Tables) are each on the 
recto (odd numbered) page.

Design Considerations

Like all lists, the Contents can follow a wide variety of formats.  Typically sections or 
parts are unnumbered.  Chapters can be indented.  Folios can appear with or without 
leaders.  

When a book has more than one such list, each is formatted the same way.

These pages are rarely numbered. See page 18 .  
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                           Facing Preface Page                                     Preface Page

The facing page is blank. Here, I am showing the first pages that has text as the Pref-
ace. Depending on your book, it could just as easily be the acknowledgment, the 
introduction, or the forward. 

This is part of the front matter. 

The Preface page may or may not have  a folio, if it does, it is usually in roman numer-
als.  

The same format is used for the forward, preface, acknowledgments (if not part of 
the preface), and introduction (if not part of the text). These pages do not need to be 
identical to chapter opening pages, but they should be visually related.

Other Front Matter

Many designers put a list of abbreviations, if there is one, in the front matter.  If the 
list is one page, it is often put on the verso page facing the first page of the text.  If it 
is longer, it should be treated like the Contents.

The facing preface page is typically unnumbered, see page 18.  
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                              Facing Page                        Half Title/Introduction/Part/Chapter

The facing page is blank. It is unnumbered.

The recto is:

The is the beginning of the Text portion of the book, as distinct from the front and 
end matter. It could be the first chapter opening page, see page 24.  

It is unnumbered. It could be counted at page 1, with the chapter opening page being 
page 3, whether it is blind or not. It could also be counted as page X, starting with the 
book’s first page, the half title. 

It could be the first page of the Introduction, a part page, the first page of the opening 
chapter.  
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                      Facing First Text Page                                    First Text Page

In general, this is how the first text page spread should look. The first text page of the 
book should be on the recto, with a blank page preceding it.

Variations

The number of options for the first text page are large, but whatever you chose, it be-
comes the model for all other chapter openings, although in traditional book design, 
the first chapter opening is the only time it must be on the recto.

The folio is usually not included on the first page.
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                                                                     Text Spread

Typically, running titles (head or foot) may be used to show:

   Verso    Recto
          Author’s name      Chapter title
          Book title      Chapter title
          Part or section title      Chapter title
          Book title      Book title
          Chapter title      Chapter title
          Nothing      Chapter title
          Nothing      Nothing
          Folio      Folio

Both pages of a text spread should have the same number of lines.

Front and back matter often have the section name (e.g. “Preface” or “Index”) in the same style as 
the running titles, and on both pages of the spread.

Running titles are omitted on:
Pages with full illustrations•	
Full page-turned tables•	
Non-run-in chapter openings •	
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                                  Block Quote                                                          Poetry

Block quotes—quoted text that is more than several lines in length, or a smaller quote set off 
for emphasis—are indented. 

Variations: They may be set in a slightly smaller type size, usually smaller by a point. The lead-
ing can be kept the same size or it too can be made smaller. Sometimes block quotes are pre-
ceded and followed by a blank line.

Poetry is usually set off by some kind of indentation. The design problem is that the text lines 
are usually of varying length. Typically:

Fixed indentation with the title: indented the same as the poem, visually centered over the •	
poem, or centered on the page.
Indented based on the position of the longest line centered, with the title indented the same •	
as the poem, centered over the longest line, or centered on the page.
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                           Facing Appendix Page                                                   Appendix

The headings for the back matter are usually based on those of the preface, foreward, and intro-
duction.

Some books use Roman numerals for the folios, usually starting at “i”. 
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                                Facing Notes Page                                                     Notes

See Appendix, page 25.

For bibliographic entries see:
A Manual of Style•	 , Chicago: generally accepted as the most authoritative guide
APA Style•	
MHRA Style•	
MLA Handbook•	

Specific academic disciplines may have unique standards.
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                             Facing Glossary Page                                                   Glossary

See Appendix, page 25.

There is no preferred style for a brief glossary. Ease of use and clarity should be the guiding con-
cern.
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                           Facing Bibliography Page                                        Bibliography

See Appendix, page 25.

The actual format for bibliographic entries follow a several different formats: 
A Manual of Style•	 , Chicago, generally accepted as the most authoritative guide
APA Style•	
MHRA Style Guide•	
MLA Handbook•	

If you need a bibliography, either follow the guidelines unique to your discipline, or if your work is 
more general, most people follow the A Manual of Style, The University of Chicago. 
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                              Facing Index Page                                                     Index

See Appendix, page 25.

A good index is more than a concordance with page numbers, although this is the easiest to cre-
ate. Distinct from a concordance, there are entries, subentries, and cross-references. A Manual 
of Syle, Chicago, is a good reference for indexing. One problem building books in programs like 
Word, is that these programs often repaginate large documents. An index that is off by one page 
might as well be an index for the a different book. One work around is this:

Create your finished book, except the index, and capture it as a PDF.1.	
Create your index as a separate document—using the book’s design specifications—based on 2.	
the PDF.  
Convert your index to a PDF3.	
Create a new PDF of your book by combining the two PDFs. 4.	
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From Manuscript to Book
With Your Word Processor

A basic guide to the concepts
for CreateSpace and other 
Print-on- demand printers

Although I recommend using a desktop publishing program (Scribus is a free, open 
source application, and Serif ’s PagePlus SE is also free), I recognized that many peo-
ple do not want to learn a new program. Yes, you can build your book within your 
word processor. There are problems, but they are not insurmountable. 

In keeping with the previous sections, this section is not intended to show you all the 
how to’s you’ll need to build your book. I have tried to address a range of problems 
that people have asked about in the CS forums.

There is no significant order to the following sections.  There can’t be, where you are 
in the process and what you need to know is different from the next person. Browse 
for what you need. 

Happy designing . . .     
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CreateSpace

This section is designed to help you prepare your book in CreateSpace (CS) from Word or Ope-
nOffice, convert it to a PDF, and publish it through CS; it is, nonetheless, applicable to anyone trying 
to follow CS guidelines and other print-on-demand printers (POD). That said, please consult the sub-
mission guidelines that are applicable to your work—this section can in no way supersede them.

As should be obvious, I do not believe there is a one-size-fits-all set of type and layout specs for 
all books, let alone any two books. If this becomes too much, higher a book designer; or, spend the 
time doing it yourself. Either way, you’ll experience something magical when you finally hold your 
book in your hand.  

The previous sections show the design tools you have: the parts of a book, the various elements 
of a page, and type. Here we will show how these are applied in practice. Word and OpenOffice are 
similar. The biggest differences are in where certain settings and menus are located. For example: 
Page Setup, where you set paper, margin, header and footer settings, is located File>Page Setup; 
whereas, in OpenOffice, it is located Format>Page. But once you find the menu the process is the 
same.   

Two additional matters: 1) work with copies of your text and image files. You do not know when 
something in a previous file is what you need days or weeks later. 2) While this section is fairly 
basic, it is not intended to show to teach how to use Word, for example. If you need more basic in-
formation, look for online tutorials or consult any of the dozens of books on Word 

Trim

CreateSpace Trim Sizes and Maximum Page Count, as of October, 2009
Trim Size Color Interior Black & White Interior

Width x Height Maximum Page Count Maximum Page Count
White Paper White Paper Cream Paper

5″ x 8″ 250 828 740
5.06″ x 7.81″ 250 828 740
5.25″ x 8″ 250 828 740
5.5″ x 8.5″ 250 828 740

6″ x 9″ 250 828 740
6.14″ x 9.21″ 250 828 740
6.69″ x 9.61″ 250 828 740

7″ x 10″ 250 828 740
7.44″ x 9.69″ 250 828 740
7.5″ x 9.25″ 250 828 740
8″ x 10″ 250 440 400

8.25″ x 6″ 212 220 200
8.25″ x 8.25″ 212 220 200

Notes: Trim sizes in bold with gray background have downloadable templates.
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            Minimum page count: 24 pages for all trim sizes, papers type, color, and black & white. 
            
Your trim size will be your paper size, unless you intend to have a bleed, see below.

For these examples, I am using a book that trims to 6" x 9".  

Margins

Once you have selected a trim size, you need to set your margins. Here are the CS guidelines: 
Inside Margins are by the book’s binding. See the chart below for Inside margin require-
ments.

Inside Margins Chart
Pages Minimum Inside Margin Pages Minimum Inside Margin

Up to 150 .375" total, .1875" each page 401-600 .875" total, .4375" each page
151-400 .75" total, .375" each page 601+ 1" total, .5" each page 

Outside margins are the page edges opposite of the finding, and the top and bottom 
margins. All live text and images must have an outside margin of at least .25" -- but we 
recommend an outside margin of .5"

Bleed If you wish for image to bleed to the edge of your book, ensure that they extend at 
least.125" beyond the final trim size for the top, bottom and outer edges and submit your PDF 
.25" higher and .125" wider than your select trim size to accommodate the full bleed area. 
(Remember that all live elements must be at least .15" away from the trim lines.) Images can-
not bleed across the middle of the book without a small white line in the books’ gutter.
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This is how you would apply the guidelines to the 6" x 9" page:

CS does not use graphics terms “bleed” and “live” in the same way as most graphic artists do, fail-
ure to adhere to the following will result in “pausing” your project. 

Bleeds 
all images, color or grayscale, must be at least 300 dpi•	
there must be at least .125" for the bleed (see right side) on the top, outside, and bottom; •	
if you have a bleed on one spread or page, the entire book is treated as a bleed;•	
all images must either: 1)stay within the white print area; or 2) bleed off the page—no image •	
can encroach into the gray “No type” area unless it extends beyond the trim into the full .125" 
bleed area;
images that contain anything that someone might consider a word or letter (CS has ignored •	
repeated requests to clarify this, so to be safe, you should consider this inviolate regardless of 
the language, legibility, or intent), what CS calls a “live element,” may not encroach the gray 
“No type” area including a .25" inner margin similar to the inner margin on non-bleed pages 
(left above)  

See examples below: 
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If the 6" x 9" book had 601 pages, it would have a 1" gutter (.5" inner margin on each page). This 
is how the page would look with the maximum text area:

For the most part, a book like this, is relatively easy to create, submit, and get printed. The top, 
bottom, inside, and outside margins can, of course be bigger, but not smaller. For a B&W interior, 
there is no limit to how many B&W images you can have. However, even one little color element 
will cause the entire book to be considered color, even if the rest prints in grayscale—it is priced as 
entirely color.   

Here is a full color bleed. Like pages spread above, there is little that is complicated, and it prints 
without problem:
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Note that the image bleeds .125" beyond the trim size, and that excess will be trimmed off. The rea-
son for allowing a minimum of .125" is to accommodate tolerances necessary to permit automatic 
trimming. The edges of images are very sensitive. Look at your image with a mask over it, removing 
the excess bleed, make sure you can live with the .25" loss. Also, there may be a white strip running 
down the middle of the spine. 

Having looked at what works, here are some problem spreads with bleeds.

Here, above, even though the book is a bleed, if the image does not extend beyond the trim line, 
then it must stay within the .25" no live element border. 
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Because of the types of printing problems faced by CS, CS will reject this image. The ostensible rea-
son is that there are “live elements” (text) within the .25" no live element border. It doesn’t matter if 
the “text” is rasterized or ornamental. (This image exaggerates the text problem.) 

For this image to be accepted and printed by CS, it must be treated like this: 

A final note on margins: although .25" is an absolute number, CS has rejected files that observed 
a .26" margin. There is no infallible way of determining what actually is a safe margin. If you are 
aware of this, at least you can be prepared if problem arise.   
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To set margins, you will go to File>Page Setup. This will bring up the same dialogue box click 
on the Margins tab:

Most of these settings are fairly obvious. Set the gutter, by 
which Word means the inner, to the inner margin you want, 
or set it in the Inner window. If you set it in Gutter, inner will 
default to a minimum. Rather than trying to decipher this, play 
with it, that is, adjust these settings until you get a page that 
looks like what you want.  

Here, I have set the Multiple pages to Mirror margins (some 
word processors say “Odd and even.”). Typically the verso (left) 
and recto (right) pages mirror each other’s margins.  

Select Apply to>Whole Document. Of course, you might 
want to change some of these for some design reason, and you 
can change that to Selected Text, This point forward, etc.

Watch the little book spread to see the effect you have se-
lected.  

Just a reminder, I am assuming that you are working on either a copy of your manuscript file or 
on a new file. You can adjust these settings over and over, and your text file will accordingly: so you 
don’t have to worry that you won’t get it right the first time. 

Next you’ll want to set the headers or headers and footers. Again, you will go File>Page Setup, 
and click the Layout tab: 

For most books, the headers differ on the odd, even and first pages. If you are using a model, 
look at how its headers are managed. Usually this is relatively easy, until you actually start adjusting 
your files. You will use section breaks (Insert>Break>Next Page), to allow you to change the head-
ers from chapter to chapter. If you don’t see a box for the header, go to View>Header and Footer, 
and click. By separating each chapter-section with a section break, you can control the content of 
the headers from section to section, using the link, or unlink, the header content. 

You are probably working on a new file and have copied your text in, or you renamed your file 
and have begun reformatting it. As you get it looking like a book, you will deal with the question of 
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type size and leading, and you may tweak your margins. At some point you will almost have it: all 
the chapters openings look the same, the title page is great, everything is fine, but there is one more 
thing to check—widows (and some designers would add orphans).  

A widow is a short ending line of a paragraph that begins the following page or column. An or-
phan is either the beginning line of a paragraph at the bottom of a page, or a very short line ending 
a paragraph. Of the three, the widow is the most offensive, and it is particularly off-putting when it 
is the last page of a chapter. Many people use Word’s widow controls (Format>Paragraph):

You use the Indents and Spacing to set the first line indent (or set it to None for centered or flush 
left elements. On the second tab, Line and Page Breaks you can set the Widow/Orphan control un-
der pagination. My experience is that Word is unstable for long books and books with complicated 
typographic effects, and the Widow/Orphan control exacerbates that: it want to add a line or two to 
a page or remove a line, and it can do this any time. You have more control if you do it yourself—it 
just takes more time. The tools you have are: expand or contract letter/word spacing (expand to add 
a line, contract to remove a line) or reducing the number of lines on the page (usually on the two 
pages of a spread) If you are pleased with Word’s Widow/Orphan control, by all means use. Here 
is a widow and I am applying the Widow/Orphan control to the just to the paragraph to show the 
effect: normally, if you use the control, it would be applied to all text.  
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Word automatically adjusted the text so that the a second line was added to the top of the page.  
I believe that one of the stability problems with Word is just this: each correction effect everything 
downstream and upstream from it. 

To remove a widow yourself, look for a paragraph with a last line that is very short or almost full. 
Then you can compress or expand the letter/word spacing to add or remove a line.

Under Format>Font>Character Spacing, you can change the letter spacing. Here, reducing the let-
ter spacing of a paragraph removed the short line, and thereby removed the widow.  

No patter what method you use, you should go through your book, spread by spread, making 
sure it is what you want before you convert it to a PDF. If you turn on auto-corrections, this gives 
you one more chance to find typos or grammar problems. When you make the conversion to a 
PDF, recheck each spread. 

PDF

If you have formatted your book to your satisfaction, save it and double check it. Do your mar-
gins meet the submissions guidelines? Are your images at least 300 dpi? Are your chapter openings 
the same? Are there widows? If you are ready, make the conversion.  

There are several way available to you, and I will look at five free methods. Word has (it was 
available for Word 2003) a PDF add-on; OpenOffice comes with a PDF export feature; pdf995, Pri-
moPDF, and doPDF are free, downloadable PDF printers (they install as printers).   

Size Installation Interface Ease of Use 6 x 9
Word add-on — easy none easy yes
OpenOffice — easy full featured easy yes
DoPDF 1.7 MB easy most features easy yes
pdf995 2.6 MB easy most features medium no
PrimoPDF 7.5 MB easy most features medium no
Scribus* 64MB easy

* Scribus is a free desktop publishing program. It offers stable and reliable PDF conversions. I have added it because 
it is a viable, free, way to generate a PDF.  
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These are subjective results. Some people have had problems where I had none, and some people 
have no problem where I have had problems. That said, these are my observations:

Check your PDF. It should look like you expect. •	
The conversion should go easily, if there are problems, before giving up, try a different application.•	
A number of people in CS forums have complained about the 6X9 trim size and PDF, therefore I •	
used it as a test: this suggests that the non-standard sizes (“custom size”) may be problematic.
OpenOffice gives the most controls (very similar to the full InDesign dialogue boxes), was easy •	
to use, and was reliable. Files created in Word can be opened and saved in OpenOffice. My ex-
perience and based on posted comments, OpenOffice preserves all formatting. 
The Word PDF add-on had no controls. This may not be a problem, but you have no way of •	
knowing what setting it uses for image compression, embedding fonts, etc. 
DoPDF, pdf995, and PrimoPDF act as printers: that is to make the conversion you start out as •	
if you are going to print the file. In the File>Print>Printer Name window, you select whichever 
one you installed as your printer. (You do not print to file.) Then you go through the properties 
and advanced settings.

Acrobat Pro and Distiller are professional level applications. Not only do they cost more than many 
alternative programs, but I am not sure they necessarily do a better job. However, Acrobat has a 
preflight feature that examines the files and will look for selected problems. Being able to preflight 
a file is a great feature; but it is not vital.

If you can or as applicable check these settings:
Embed all fonts•	
Deselect “Subset embedded fonts”•	
Compression and Downsampling: •	

JPEG Maximum quality •	
Downsample for color and grayscale images above 320dpi to 305 (elsewhere CS says that •	
images should be at least 300 dpi)

Set compatibility to acrobat 5.0 (PDF 1.4)•	
Color management: select Leave Color Unchanged•	
Bleeds and Compression: Use document bleed settings •	

Type

Most free fonts do not come in full families: Roman, italic, semibold Roman, semibold italic, 
bold Roman, etc. Word will let you create an optical bold, italic, bold italic. These are not true fonts 
and you may have serious problems printing. Yes, you can make a PDF and it will look like you 
want, but the type effects are not embedded fonts, and CS might reject the file.

To avoid these problems, if you are going to use italics and bold, make sure they are separate 
fonts. Some true italics, bold, etc., are actually listed in your fonts window as separate fonts (e.g. 
Requiem Italic, Requiem Roman); or some (e.g. Adobe’s Minion) have only one listing, Minion, but 
but do have a true italic, bold etc. 

One way to tell is to look in your fonts folder (Windows>Fonts). Each font should have a separate 
icon. If you double click on it you’ll get a type sheet with the name of the font, the basic set of letters 
and numbers. You can print this a build your own type book. What you will not see are the com-
plete set of glyphs for that font. For this, the easiest thing is to look at the Character Map (Start>All 
Programs>Accessories>System Tools>Character Map, as long as you have this send a copy of the 



43

icon to your desktop), or in Word, Insert>Symbol. 
Another way to determine if you have a true italic, is to look at the letters like “a,” which usually 

are different between Roman and italic: e.g. “a” versus “a”; whereas “a” versus “a” is indicative of the 
sort of artificial italicization that Word does if there is not italic font.       

Cover

CS provides a cover maker, but to have full control over your cover, you can make your own. 
First you need to know the guidelines:

You can build your cover in a wide variety of programs, including OpenOffice or Gimp. Although 
Gimp does not save as PDF, you can create a cover page in OpenOffice, and save it from there as a 
PDF.

The key to understanding making your cover is that you must work within the physical guide-
lines. All covers are printed in color, whether they are color or black and white. 

Copyright

The best source for information on copyright matters is the Copyright Office, http://www. copy-
right.gov/. 

Your work is automatically copyrighted, but unregistered, at the time it was created: publica-•	
tion and registration are not required.
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Registration established the actual date of registration; it does not necessarily prove authorship, •	
but it provides additional damages in an infringement case if won.
Use of copyright notice is no longer required under U.S. law.•	
It is illegal for anyone to violate any of the rights provided by copyright law to the owner of the •	
copyright: these rights are enumerated in the law.
If you include notice, it should contain the symbol © or the word “copyright,” or the abbrevia-•	
tion “copr,” the year of publication or the year the work was completed, and the name of the 
owner, if it was not a work for hire, that is your name. For example: © 2009 John Doe.
The keyboard shortcut for the copyright symbol is hold down <ALT> and 0169, release •	
<ALT>
A lot of registration can be done electronically; look for the large “e” on the copyright web •	
site.
A collection of stories may be copyrighted as a single work. •	
Sending your work to yourself registered mail is not the poor man’s registration, it is no regis-•	
tration at all.
Fair use is intended to permit commentary, parody, news reporting, education and research. •	
Quoting a small amount in a novel is not fair use. If, however, the work is in public domain, 
then there is no problem quoting it.  
Although derivative work is recognized, you must have permission or the work must be in •	
public domain. 
The term of a copyright, after which the work enters public domain, varies, see http://www.•	
copyright.cornell.edu/resources/publicdomain.cfm for a simple easy to read table, of general 
concern as of January 2009 in the US: a work published before 1923 is in public domain; unpub-
lished works either created before 1889 or for authors who died before 1939.  

ISBN
 
The International Standard Book Number is administered in the US by R.R. Bowker, http://

www.bowker.com. Their site(s) are a bit daunting, so when you find what you want bookmark the 
page. 

CS requires an ISBN, which identifies the book title, author, and publisher. You can buy your 
own or get one from CS. If from CS, then CS is the publisher. If you want to be John Doe Publisher 
to the Stars, you need to buy your own ISBN.  

The ISBN appears on your book’s back cover inside a white rectangle, with a bar code. Bowker 
will make a bar code for you for a fee, but there are free services on line. 

If you have the option, you want the barcode as a TFF, JPG, PNG, GIF, or BMP file. If the bar-
code is on transparency, you will need to provide a white box for it in your back cover. 

Images

Even if you do not put images in your book, your cover will probably have an image. There are 
some terms that need to be defined to make some of this section clearer:

aliasing:  a distortion or artifact produced when an image is viewed: a digital file is reconstructed 
(interpolated) to be seen on a monitor or printed. When that image differ from the original, 
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it is an alias..  The two most common for forms of aliasing are Moiré patterns and what are 
commonly called jaggies.

antialiased:  is a technique for reducing or eliminating the effects of aliasing. In most graphics 
programs, and for most users, the single biggest aliasing problem is jaggies:  antialiasing adds 
mid tones between jaggies. 

                                 aliased                                                                               antialiased

aspect ratio:  the ratio of the longer dimension to its short dimension.
bitmap:  although Photoshop uses “bitmap” to mean a black and white image, i.e. one bit of datum 

is either 1 or 0, therefore black or white. Bitmap more generally is used to mean any image 
composed of a fixed amount of pixels, whether black and white, or full color (16 million 
colors)—as opposed to vector based (also called object oriented)—images. Think, the image 
is mapped bit by bit. The size of a bitmap image file is directly proportional to the size of the 
image, thus 4” x 4” image is 4 times the size of a 2” x 2” image. 

bmp:  sometimes called bitmap. This is the native format of MS Paint.  Bmp images can be B&W, 
grayscale, indexed color, or full color.  

canvas:  independent of the image size, the canvas or background area of the image can be en-
larged. 

CMYK:  A color scheme for representing color images using Cyan, Magenta, Yellow, and Black in 
a subtractive model.  When all four colors are added the resulting color is black.  The absence 
of all color is white. It is most commonly used in printing. Most good inkjet prints actually 
use CMYK, inks. 

compression:	 a process of encoding the information that makes up an image using fewer bits than 
an unencoded version. For example, an open 5” x 8” 300dpi image is 10.9 MB, with JPG com-
pression at maximum quality, the files saves at 1.6 MB, 4.3 TFF with LZW compression, and 
a 11.2MB for TFF with no compression. 

crop:	is the reframing of an image, by removing outer parts. It is done to accentuate the subject or 
change the aspect ratio. Most graphics programs have a crop tool, although unnecessary for 
cropping, often do several additional things: align or rotate, or correct perspective effects. 

dpi:  dots per inch. This can mean several different things. Most people use it to mean pixels per 
inch. Dpi, for example, can mean the number of ink dots per inch that a inkjet printer pro-
duces.  

eps:	 Encapsulated Post Script, a object-based (vector) file format 
feather:  to feather is to blur or soften an edge.  It is an effect applied in addition to the antialiasing 

applied by many tools.  
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flatten:  Images made up of multiple layers appear on your screen as one, homogenous image.  Flat-
tening merges the layers into one layer, with everything visible locked into place in that one 
layer. Because all the layers have been merged, making adjustments or changes after an image 
has been flattened can be difficult.  

flop:  to reverse an image either horizontally or vertically. 
gif:  Graphics Interchange Format, this image format compresses files in part by using indexed col-

ors.  Gif files can preserve transparency.  
handles:  certain bounding, rectangular, boxes, see selections, have little squares at the corners and 

middles of each side.  These squares are handles that can be dragged to transform the box.  
image size:  the physical dimensions of an image: 2” x 2”, or 600 px x 600 px.  See Size vs Resolu-

tion
indexed color:  to reduce the file size of images, a color image is remapped to define a unique pal-

ette for that image—think of paint by numbers—where the color data is indexed to the pal-
ette rather than inherent in each pixel.  The image, hence the palette, is reduced to a limited 
number of colors ranging from 1 or 2, to 256, whereas the image you take with your point and 
shoot digital camera can produce 16 millions colors

jaggies:  an artifact of aliasing in bitmap images. See antialiasing. 
jpg:  or JPEG, Joint Photographic Experts Group, is the most efficient and standard compression 

format in use.  Although it is a lossy system, but it gives the option for how much compres-
sion—therefore how much is lost—prior to saving the file.  Once saved, opening and closing 
the file is safe, however, opening and resaving loses additional information.

layer:  the digital equivalent of acetate cells in cartoon making.  Layers can be transparent with im-
ages on them, therefore letting what is below show through.  

lossless:  a type of compression that does not lose image data to enable smaller file sizes when the 
image is saved.  PNG and TIFF LZW are lossless. 

lossy:  a type of compression that loses an amount of image data to enable smaller file sizes when the 
image is saved.  Jpeg compression is lossy. 

marching ants:  when a selection is made in a graphics program it is surrounded by a dashed line 
that moves along its path. 
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mask:  a mask can be any selection or painted in or out area that blocks or permits an effect or edit.
Moiré pattern:  is an interference pattern.  It is commonly associated with line art, scanned halftone 

images, and images that contain repeating, linear patterns.    
native format:  Many applications have a file format that is maximized to take the most advantage 

of that application’s features. Graphics programs often permit saving and opening files in 
both native and common file formats. Examples are PSD (Photoshop), RIF (Corel Painter), 
or DOC (Word).   

object:  You create objects in drawing programs, which are often called object- oriented; synony-
mous with vector or vector-based. Such objects are defined mathematically. The size of the 
definition is independent of its size; thus the size of the image, whether 2” x 2” or 4” x 4”, the 
files size is the same.  Most common digital type is vector or object-based.  Aside from rela-
tively small files sizes, object-oriented shapes are have very smooth edges.

path:  a path is a object-oriented outline. Usually paths are converted to selections to enable most 
edits.

pdf:  Portable Document File, the file format for Adobe Acrobat. It was developed to enable the 
capture and transmission of documents (text and images), independent of the operating sys-
tem, hardware, or applications.  

png:  Portable Network Graphics, developed for the web to provide 16 million colors while preserv-
ing transparency. It uses lossless compression.  One problem, however, is that some graphics 
applications don’t work well with png files. 

POD:  print on demand publishing, for example, CreateSpace, Lulu, BookSurge.
ppi:  pixels per inch.  Most of us use dpi to mean ppi. (Although ppi is correct, I have used dpi 

throughout, to avoid confusion with posted guidelines.)
print image:  the output devise is a printer.  For POD books, the resolution is 300dpi. 
raster:  a general term for a scan or image pattern made up of dots or pixels.   
rasterize:  the conversion of on object based image (vector) to a bitmapped image.
resampling:  when an image is resampled, each pixel is assessed with the aim of enlarging or reduc-

ing the image; the image file size will change proportionately.  
resolution:  is the number of pixels per inch. A 1 “x 1” image at 72dpi contains 72 x 72 pixels, or 

5184 px total; whereas a 1” x 1” image at 300 dpi contains 300 x 300 pixels, or 90,000 pixels. 
Because each pixel contains color information, the 1” x 1” 300dpi image would be a better 
image than the 72 dpi version. The question of the “best” 

resolution:  is somewhat moot in POD publishing, because 300 dpi is the preferred 
resolution:  See Size versus Resolution
RGB:  a color scheme for representing color images using Red, Green, and Blue in an additive 

model.  When all three colors are added the resulting color is white.  The absence of all color 
is black. Typically monitor are RGB. 

rip:  raster image processor is a stage in the printing system where a raster image is produced then 
sent to the printer or output device. It is essential for printing vector information or when a 
bitmap is of a resolution other than the printer or output device.

screen image:  the image you see on your monitor is RGB.  It differs from the printed image: 1) it 
is transmitted light; 2) it is RGB; 3) the video card optimizes the output, and although it is at 
screen resolution, it created the illusion of greater detail and smoother tonal transition  than 
the image actually has if printed.

selection:  an area of an image-layer that has been selected by creating a border around it. Borders 
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can be drawn, created by controllable shapes (square, rectangle, circle, oval, etc.) by color, by 
transparency, etc. Whether the selection will be used as a mask, copied, erased, painted, etc., 
can only happen once it has been made—in other words, you have to tell the graphics pro-
gram what is to be edited before you can do anything.  The default for most functions is the 
entirety of an active layer.  

size vs resolution:  The size of an image can be changed two ways: 1) resampling on;  2) resampling 
off.  With resampling on, changing the size of your image will result in resampling: if the reso-
lution stays the same, the software will add or remove pixels to resize the image and the file 
size will increase or decrease.  However, with resampling off, the files size will stay the same 
when the image is resized, and the resolution will increase or decrease proportionately.  

Each image is 191KB. The smallest is 300dpi, and would print nicely.  The largest is 18dpi; and 
as bad as it is it here, a print of it would be much worse.

stroke:  in graphics, when a line of a given thickness and color is made following the marching ants 
of a selection.

styles:  are graphic effects—drop shadow, inner glow, emboss, curves, blending modes, etc.—that 
can be applied to a selection or image. 

tablet:  is an input device (similar to a mouse) that allows drawing with a stylus. Unlike drawing 
with a mouse, tablets have hundreds of pressure levels that can change the quality of a line is 
made: lighter-darker, wider-thinner, etc.  

tif:  Tagged Image File Format, a file format that can preserve layers and that uses lossless compres-
sion. 

transform:  in graphics programs the contents of a layer can be selected and transformed: rotated, 
scaled, skewed, or distorted. 

vector:  See object.
white point: because white varies (e.g. orange with incandescent, greenish with fluorescent, blue 
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The reason this is the longest section, is that its language and concepts are the most foreign to 
the average person who has written a book, but is not a digital artist. There are two types of pro-
grams: drawing and photo-editing—both names are misleading. Drawing programs does more 
than drawing; they tend to favor object-oriented art. Photo-editing programs do a lot more than 
edit photos, most work with type, have brushes for drawing and painting, etc. For most people, 
photo-editing programs are what you need. 

There are two aspects to learning these programs: 1) you must learn the concepts and what they 
mean in practice; 2) you have to learn where the tools are. Here are my rules: 

Ask: •	 “What do I want to do, and how do I want to get there?” (There ar
Always work with a copy.•	
Do not flatten your work file. Flatten a copy.  •	
Save your work often.•	
Stop every 15 minutes, stretch and blink your eyes.•	
If you are going to do much graphics work, use a tablet.  •	

What to use: 
Free
OpenOffice has a drawing program that has layers. For images it has a few rudimentary controls, 

aside from resizing and cropping, you can adjust the red, green, blue, brightness, contrast, 
and the gamma curve. 

Gimp is a “full feature” photo-editing program, comparable to Adobe Photoshop.  It can do quite 
a bit of what Photoshop can do, although it is a little clunky.  Experienced Photoshop users 
will miss a lot. 

Serif PhotoPlus (SE, free, V9 $9.99), offers all that you need for basic photo-editing and 
Inkspot is a “full feature” illustration program, comparable to Adobe Illustrator. It’s forte is object-

oriented art.
$70-100
Adobe Photoshop Elements: In an attempt to make it user friendly, it is quite difficult for Photo-

shop users. By selecting certain tasks, related desktops and menus become available. For a 
novice, this might simplify things. 

Corel PaintShop Pro may be the best of this category, it has the easiest user interface.  
Serif PhotoPlus X3 has the advantage that it resembles the other programs in the Serif family.   

There are several ways you will images: you can buy an image (stock photos are available from 
stock photo houses from free to just a few dollars); you can scan work; and you can shoot things.  

Scanning Art 

If you have created art work, or have photographs (prints) that you want to use in your book or 
cover, the best way to convert them to digital files is to scan them. Depending on the original art, 
the actual scanner, and the graphics software used to correct the scans, it is possible to make ac-
ceptable scans for your book.  

Most desktop scanners have all sorts of controls to make a scan:
Sharpen•	

morning light, warm evening light), although we white as white, your camera and scanner do 
not. Setting the white point helps to reduce color casts. 
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White point •	
Color•	
Contrast•	
Brightness •	

These are algorithmic programs that the scanner uses to adjust the scan. Which has more resources 
available for this, your scanner or your computer? If your scans are perfect for your purposes, you 
don’t need to consider the following, but most scans can be improved. If possible, do these things 
yourself in a graphics program. You can see how your image looks as your work on it, and you can 
print it out to proof it. 

Your goal in scanning is to capture as much information as possible. A professional studio will 
calibrate their scanners to do as much as can be done well in them at the time they scan, but the are 
experts who know how to evaluate the capabilities of their equipment and they have a profit motive 
to get as much done well but quickly. When you scan:  

Scan in color:  even if you are going to convert your image to grayscale.  •	
Scan at the highest optical resolution: your scanner will have two maximum resolutions, opti-•	
cal and interpolated (which uses software to enlarge the image, if you need this, you can do it 
better on our computer). Only if memory or patience is a problem, set the resolution to no less 
than 300 dpi.   
Do not sharpen.•	
Do not apply contrast and brightness settings, or use just the minimum. •	
Do not adjust the color.•	
Do not crop too close to your image.•	
Do not use a straighten feature.•	
Adjust the white point in the scanner, if necessary.•	
If your scanner permits multiple passes to minimize chatter, consider it.•	

In your graphics software, as outlined above, make the necessary corrections to a copy of your scan. 

Shooting Art

Things were harder in the film only days, and professional photographers used copystands to 
make transparencies or copy prints of your work. 

The good news is that if cannot scan your work, you can use an relatively inexpensive digital 
camera, and with almost any photo editing program you can get an acceptable picture of your 
work. 

Your goal is to get a distortion free picture of your work, with no glare (reflection or flare) and 
reasonable color, contrast, and brightness. The explanation may seem complicated but the pictures 
should make things clear. If you understand the principles, you’ll understand what you can get 
away with and what you can’t. The advantage you have with a digital camera, is that you can in-
stantly review a thumbnail of your shot and make immediate corrections to your set up. 

Your setup will: 
·  reduce camera shake and in you cannot hold a camera dead still.
·  have as much light, without flare or glare, as possible
·  enable you to shoot as a slower speed (if your camera permits you to set the ISO, you should 
prefer lower settings, for example, 100 will have less grain than 800).
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This section is about the physical set up to shoot your art. Capture as much information as pos-
sible, and use graphics software to adjust your images: don’t rely on your camera. Keep notes of 
what works. Basically:
1) Use a digital camera: so much easier and less expensive than scanning film; and you can in-
stantly see if your setup is working. 
2a) Mount your camera on a tripod: keeps your camera steady and in the exact position you need. 
Most cameras have a small, threaded hole in the bottom to accommodate a tripod. 
2b) If you don’t have a tripod, you may be able to get decent pictures if you understand the prin-
ciples.
3) If possible, use a cable release or timer on your camera: keeps your camera steady when you 
click the shutter
4) Make the planes of the art and the camera (the lens and the film/sensor) are vertically and hori-
zontal parallel: reduces distortion. 
5) Use two (or four) light sources at 45° to the art: provides even light that doesn’t cause flare.
6) Use a photoediting program to adjust your image, see scanning above.

When you get a setup that works, sketch it out in a notebook with dimensions and any data you 
might need. Yes, you’ll remember it tomorrow, but maybe not in six months. 

Ideally:

(Looking down)

(Viewed from the side)

The camera lens is centered on the art work, and it is vertically and horizontally parallel to the art 
work.
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Two lights (four if you have two on a side, one at the top and one at the bottom of the work aim 
in at the work with about a 45° or less angle.

In case you took life drawing and skipped science: The angle of incidence is equal to the angle 
of reflection: so in an ideal world the glare bounces off away from the camera.

Some surfaces (glass or plastic, Ilfochromes/Cibachromes, highly varnished) may still have 
some flair. If you still have flair or only have one light, you might try this:

The one light method isn’t perfect, but it reduces the amount of light that could be reflecting up 
into the camera: however, more light will fall on the side nearer the light, therefore it will be lighter 
and the opposite side of the image will be darker. How much? I can’t say. You’ll see in your photo 
editing software. You might be able to use a black to transparent gradient (adjust the opacity way 
down) over the image to balance the lighting if it is too noticeable. Polarizing filters can help if 
your camera can take filters. Diffuse light can help.

Here’s the down and dirty way (exaggerated):

I have leaned Mylar covered art work against a wall, sat holding a 3MB digital camera with 
flash, shot at an angle. There was no flare. But the picture was quite distorted. In Photoshop I 
straightened it out. Printed it at about 9” x 12” and it worked okay.  

What you cannot do is this:
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Here the light source will bounce off the work and back into the camera: flare! Remember, this 
light source could be a window behind you or an open door. 

I prefer to shoot vertically: 

There are two lights, equal distant from the center of the art, and aimed down 45°. This is a poor 
man’s copy stand. I use a level to adjust the camera so that it is parallel. 

Although I have a tripod with a side arm, I have used a Tiltall tripod, which allows the column 
to be turned upside down. The camera is mounted between the legs, which straddle the art.

This works great, but it takes up some floor space, and you do have to be careful not to step on 
your work. 
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